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Project Manager  

Project management in MoviePack is basically the display of the enitre
project on one monitor, the program interface. Individual tools are
found in every window. 

Obviously everyone has their own personal way of working, which is
why MoviePack is user-configurable. You can design your own
individual workspace to suit your tastes or different projects. The various
interfaces can be saved and used later. Project specific interfaces can
be easily created and saved for various users (e.g. beginners, more
advanced, experts). 
Project Manager
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Project Window  

 

Menu bar: Contains program functions as pull-down menus

Browser

Window* Icon bar

TimelineTimegraph

Canvas

Standard* Icon bar 

Source Preview Effect Box

Live Preview in Realtime Timeslider

New Album

New Transition

New Animation

Open
Render

Copy
Save

Insert
Help

New Object

Timegraph

Timeline

Activate Browser

Effect Box

Open Album

Monitor

Preview

Video Control

All windows can be floating or
docked.
Manual Tutorial Reference Effects
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Adjusting the Desktop

MoviePack works with Microsoft Windows and behaves just like
Windows with regards to the enlarging, reducing and closing of its
windows. The same also applies to the use of the right mouse button to
change numerical values, and other similiar tasks.

The contents of numerical input fields can be
copied, deleted, cut and inserted. This proves to be
quite helpful particularly when the same numbers
are repeatedly used. To do this right-click in the
number field. 

u Open a window in MoviePack by clicking one of the icons
in the window icon bar or from the Window menu choose the
window you want. You can also activate windows by
clicking Palette on the View menu.

Tool Tips indicate the windows which are concealed behind
the icons.

u To close the window click . 

I The main window in MoviePack is the active window with
the blue title bar.

u To alternate between windows, simply click each window in
turn.

I Using the shortcuts Ctrl+ Tab and Ctrl+ Shift + Tab you can
move from one window to the next or to the previous window
(animation or transition).

Joining WindowsToo many windows opened at the same time can make the interface
look quite confusing. A more user-friendly desktop can (subject to your
monitor) be created by attaching the windows to one another.
Adjusting the Desktop
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Attached windows take up
only one window on the
interface and the user can
easily switch between
them.

u A right-click on
the title bar of
your window
opens a menu
containing the
command Attach
to.

u After clicking on
Attach to a selection of windows will appear. The active
window can be attached to any one of these windows.
Simply click the desired window.

alternatively:

u To join two windows, first click on the window icon (top left)
and drag the window - the mouse cursor changes to this icon

 onto the title bar of another window. When the pointer
changes to this symbol  release the mouse button and the
two windows are joined.

I The active window moves onto the position of the other
window and hides it.

Dots after the name of the window in the title bar indicate that there are
other windows hidden behind it. The icon of the hidden window is
shown either to the right of or under the window title.

u Click one of the icons in the title bar to display the
corresponding window.
Manual Tutorial Reference Effects
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Detaching WindowsTo detach the windows you have two
possibilities: 

u A right-click on the title bar activates
a menu with the new command
Detach. This command allows the
active window to be detached.

alternatively:

u Click on the window icon (right hand-
side of the title bar) and drag the
window into a vacant space. The
pointer appears like this .

Window Setup

Every window can have a fixed position i.e. it can be docked. Docked
windows will always try to fill the space between the other windows.
This method of joining windows results in a better orientation and uses
the limited space on the screen effectively. Docked windows can vary
in size but can no longer freely move until the docking is deactivated
(floating).

Windows can be arranged in
any way you wish. By clicking
the icon of the respective
window a menu appears
containing the command Dock.
This command docks the
window to the borders of the
program window. The title bar
is vertical when a window is
docked.

Moving Windowsu Click the title bar of the window and drag it into the desired
position.

u Double-click the title bar to free the window from its anchored
position. It moves to a central position on the screen or to the
position it previously held before being docked.
Window Setup
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. I Allow Docking is automatically activated when the window is
docked. If the window is moved about the screen when Allow
Docking is activated, the outline of all available positions is
shown. By releasing the mouse button the window stays in
the desired position. Only by deactivating Allow Docking can
the window once again move freely.

Floating Windows u A menu will appear with a right-click on the title bar. Choose
the command Floating.

I A floating window is no longer integrated into the project.
When moving or minimizing the other windows, they remain
inside MoviePack’s borders but a floating window on the
other hand can move outside MoviePack.

I Double-click the title bar of a window to free it and a further
double-click will return it to its docked position.

I The window retains its old position until a new one has been
allocated.

MDI Child MDI Child is an exception. By activating this
control the window moves to the middle of
the screen and only when activated can it
overlap other MDI windows. It is subordinate
to the other windows. Apart from this
peculiarity it behaves like any other floating
window. As with docking this allows the
screen to be used more efficiently. 

An MDI Window has three icons on the top right  which can
be used to minimize, maximize and close the window.

Adjusting Window Size To change the size of the windows use the Windows method:

u Position the mouse on a border or corner of a window. The
pointer adopts this form . Drag the window to the
desired size.
Manual Tutorial Reference Effects
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u The width and height of docked windows can also be
altered. Position the pointer on a border of the window and
it will appear like this . Drag to the desired size.

I If several windows are docked to the one edge you can move
all of them inwards using one border line. For example, if
you want to enlarge a window which is positioned at the
bottom edge you can move the common border line upwards
making the entire row higher. Adjoining windows behave
depending on the mode.
l Docked windows are moved higher or apart.
l Floating windows overlap the row.
l MDI windows move under the row.   

u Docked windows which overlap each other can be
minimized and then restored by clicking on . Maximizing
reduces the neighboring windows to title bars.

u In floating windows this button appears . It minimizes
the window to a title bar. The icon then changes to 
which restores the window to its original size.

A double-click on the title bar also minimizes the window and
a further double click will restore it to its original size.

FloatingDocking MDI Window

Docked Rows
Window Setup
Project Manager REF 11Manual Tutorial Reference Effects



   

12
Configuring MoviePack 

Setting up Image Format The image format in the Canvas does not influence the video output,
rather it acts as a control. For the output either PAL for TV or 320x 240
for Multimedia CDs can be used. Irrespective of this you can also output
your animations in different resolutions.

You can access Animation setup either from File / Animation setup or right-click
on the Canvas. Here you can choose the resolution and the background
color and save this data as readily available Schemes.

A large format (e.g. 800 x 600 or PAL) means the composition is
displayed precisely and with a high resolution but it might cause
playback on a PC monitor to be slightly jumpy. Small formats will create
a smooth playback as there is not so much data to move.

The only relationship with the final output is the ratio setting.

Whether the setting is 800 x 600, 768 x 576 or 320 x 240, the 4:3
ratio is always the same. To process PAL or NTSC videos you must only
heed the ratio.

If you set the Canvas to 500 x 200 and use images and videos to their
full size, your video will appear distorted. If you select the render setting
PAL or NTSC, 500 x 200 will have a ratio of 5:2. It is better to maintain
the default settings for PAL and NTSC.
Manual Tutorial Reference Effects
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Trick Do you want to create a video full of effects, for example 
having several videos running and filming them with an 
virtual camera moving from left to right?  

It now makes sense to choose a totally different Canvas setting but still use
PAL or NTSC.

u The individual objects have to be moved to their positions
respectively. They will then run parallel to each other.

PAL or HDTVTry to use the settings you would also like to use in your video. The
selected image format does not effect the render quality, however object
ratios are not judged optimal if the wrong image format is used. 

Saving ProjectsIf you are satisfied with the layout and design of your monitor, save it
as a project.

While the five clips are played back the camera moves from left to right. 
The output shows a video in PAL or NTSC (4:3) which has been generated 
by a virtual camera.

Canvas in 4:3 TV Format Canvas in 16:9 HDTV Wide Format
Configuring MoviePack
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u Click the Save Project command on the File menu.  

u The previously chosen folder appears. If you want a different
one, search for it using the Windows functions.

u Enter the name (with filename extension ’.M3W’) and then
click Save.

Loading a Project u An existing working environment can be found under File /
Open Project.

I If you want to reuse a recently used project, click Recent Projects
on the File menu. A list of the last 8 projects will appear.

Capture To process video footage your computer needs a capture card. The
external cable of the source must be connected to this card. Further
details can be found in the ’Reference - Capture & Render’ booklet.

u From the Tools menu select Capture.
Manual Tutorial Reference Effects
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Determining Storage Location

If you are happy with your project, search for and save all MoviePack
files on hard disk. Choose the location where MoviePack is to access
the objects. This way the workflow can be optimized while at the same
time fragmentation and a capacity overload of the disk drive can be
avoided.

Select Storage Location u Open the Options dialog box from the Tools menu. Select the
File Locations tab.

The available folders are listed on the left-hand side of the window. On
the right the current storage location is displayed.

Captured files:  In the Tools menu MoviePack offers its own Capturer. If
nothing else is specified the captured footage is saved in Captured Files.

Temporary video files: While working with MoviePack video data is
constantly being added. This data needs to be temporarily saved and
for this there is a temporary video folder. 

Additional plug-ins: Here additional plug-ins from AIST or from third party
manufacturers are stored.

Additional Footage: Here you will find further image and video footage.
Determining Storage Location
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Changing Storage Location u In the dialog box click the New (Insert) icon . A new folder
is created. If you know the file path you can insert it.
Otherwise click on the three dots  situated next to the
insert bar. This calls up the next folder which enables you to
determine the path.

u The Select Directory
dialog box appears. 

u As in Windows
Explorer select the new
folder and click OK.
The new target folder
has been chosen.

For each folder it is possible to select several different storage locations.

Deleting Target Directory  To delete a target directory, click the button with the red cross in the
Options dialog box

The two arrows enable you to move the pointer up and down the rows
of the target directory.
Manual Tutorial Reference Effects
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Configuring Icon Bars

MoviePack offers you the possibility to reconfigure or newly define
existing icon bars. As a result frequently needed functions can be
combined and you can create your own individual Canvas.

Opening CustomizeMany MoviePack
functions are
represented by an
icon. These can be
found, together with
a short description of
their function, in the
Tools menu under
Customize. Three
categories exist in
the default setting:
the Menu command
bar and the two icon
bars Standard and
View.

u Click the Commands tab; a list of the current icon and menu
bars appears. When you choose one, the appropriate icon
or menu name will appear on the right-hand side.

Deleting and Inserting 
Icons in the Toolbar

u Icons or menus from the existing icon and menu bars can be
dragged and inserted into other bars.

u To delete, drag the icon out of the icon bar and then release
the mouse button.

Restore Default Settingu In Toolbars in the Customize box select Reset.

I In the Toolbar tab it is possible to change the size of the icons
and also to choose either raised or flat buttons (Cool Look
option). 

Standard Icon bar
Configuring Icon Bars
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Creating a New Toolbar u Drag one of the icons out of the
Customize box and a new unnamed
toolbar will appear. Add as many
icons as you want and give the new
toolbar a suitable name. 

u Under Tools/
Customize open the
Customize dialog box.
Here you will find a
list of toolbars. 

If you want to create
your own toolbar
click New.

u In the New dialog
box type in a name.

u Click OK and the
new name appears in
the list.

Deleting Toolbars u Highlight the toolbar in Customize/Toolbars and click Delete.
Only user-defined toolbars can be deleted. Menu, Standard
and View are maintained.

I A click on the cross in the top right corner conceals the
toolbar.

u With a double-click, or by moving with the mouse, the icon
bar moves to the second top bar or moves into a new row. A
double-click on the remaining View, Standard and Menu bars
changes them into freely moving toolbars.

User Defined Commands

User Defined Commands on the Tools menu allows you to create new
commands with their own names and whatever commands or program
call ups you desire.
Manual Tutorial Reference Effects
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u Open the User Defined Commands menu and then click Add. Enter
a chosen name and click on the button with three dots in the Command
bar to select the desired application on your mass storage.

In this example two tools have been created under Tools which can now
call up programs from MoviePack.

1

2

3

4

User Defined Commands
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M3 Import Export System 

In the Windows taskbar you will find an icon with the MoviePack logo.
To the left is a small bar which shows the activity of your MoviePack
project.

Double-click the small bar and the following statistics appear as well
as... 

... the Settings for memory management.

MoviePack temporarily saves data for the
preview.

The Proxy file directory acts as a
temporary storage. The more proxy you
have, by entering an appropriate drive
with a lot of memory, the faster the Preview

and other memory dependent functions will run. The default 1000 MB
is normally sufficient.
Manual Tutorial Reference Effects
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Windows in MoviePack

After starting up MoviePack, the standard windows or a Standard project
appear if you selected Open Project.

l Canvas window

Creative area in which compositing takes place.

l Browser

Here you will find all sources such as effects, movie clips, still
images, image sequences, transitions and audio etc.

l Preview

This provides you with a preview in real-time of the chosen
scenes.

l Timeline

This provides you with a temporal overview of the project,
video transition and audio tracks.

l Timegraph

With its keyframes this enables each effect to be manipulated
over time. 

These are the most important functions that are needed for the
processing of an animation. To start with we recommend that you keep
the default configuration. In the following pages you will receive a short
introduction to these windows, more details can be obtained from the
specific booklets. 
Windows in MoviePack
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Canvas Window

The Canvas window is the main window in MoviePack. Each Canvas
contains an animation which consists of still images, movie clips, audio,
transitions or effects. 

Opening Canvas Window After starting up MoviePack a dialog box always appears in which you
can insert the data for your Canvas. To open a new window click on New
Animation.

I Several animations can be worked on simultaneously
depending on the memory available. Each animation has its
own Canvas window. To activate simply click the window and
the activated window will appear in the foreground.

Inserting Objects u To insert an object onto the Canvas, double-click it in the
Browser. The object will then simultaneously appear in the
Timeline, Timegraph and the Effect Box.

I Frames can only be seen in the Canvas and the Effect Box if the
Timeslider is positioned on them.

Deleting Objects u Active objects have a stripey border in the Timeline and
appear on the Canvas with borders and handles. They can be
deleted using the Del key or under Edit / Delete.
Manual Tutorial Reference Effects
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Using the MouseWhen you insert a new object such as a Movie Clip, Still Image, Titler etc.
into your project, the Transformations icon is automatically shown in the
Effect Box.

MoviePack enables you to position, scale and rotate the objects. These
movements are carried out directly on the Canvas.

Moving, Rotating and 
Scaling Objects

As soon as an object on the Canvas, and therefore also in the Timeline,
Timegraph and Effect Box, becomes active, it is framed with the standard
yellow border. Handles are fixed to the corner and middle points of
each border. With these handles you can move and scale the object.

Changing the Handles u A frame with square handles appears after one click on the
object. The object is now activated and its size and
proportions can be changed.

u A second click on the object changes the squared handles to
round ones and the object can now be rotated using these
handles.

u Using the green center point the object can be moved around
the Canvas. A line indicates the path the object takes when
moving from one position to another. A trajectory is created.

Motion CurveIf the object has to move back, the
time must also be adjusted for each
step. 

As a default setting the object is
positioned in the center of the
Canvas. Now adjust the Timeslider in
the Timeline or the Timegraph using the
triangle at the top of the Timeslider.

Finally return to the Canvas, move your object and adjust the time once
more.

Detailed information can be found in the ’Reference - Canvas’ booklet.
Canvas Window
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Browser Window 

All objects (sources) whether they are still images, movie clips, effects,
transitions or audios etc. can be selected in the Browser

Using the file directory on the Desktop, you can select whatever file you
desire. The MoviePack Browser is able to independently access files of
the chosen object type thanks to a filter.

Alternatively you can access the object through the object groups. If you
want to insert an image (e.g. a TIFF file) and are in a folder which
contains only sound or AVI sources, the Browser will not be able to offer
you a selection.

MoviePack objects (artificially generated by MoviePack, such as
Procedural Images or Titler) can also be found and selected in the Browser
but they do not physically exist on the hard disk.

Source Viewer As sources cannot be adequately judged using the thumbnails a Source
Preview is provided.

Position the pointer over a
thumbnail. A preview of a
clip or an enlarged view of
the still image appears.

More details can be found in
the ’Reference - Preview’
booklet.

To become better
acquainted with the Browser
refer to the ’Reference -
Browser’ booklet.
Manual Tutorial Reference Effects
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Timeline Window 

In the Timeline you can manage your object over time. On the Canvas you
see the image of your animation at the point in time where the
Timeslider is positioned. The display of objects on the Canvas follows the
sequence of how the objects are arranged in the Timeline.

The head of the Timeslider is a
virtual camera which ’sees’
objects as layers which have
been placed on top of each other.

T
The Timeslider can be
moved by either
dragging or by using
the arrow keys. 

I The Timeline
consists of three areas:

l the compositing or animation area 

(Track Video 1 to unlimited amount, pastel green)

l the editing or cutting area
(Track Video A - Transition Track - Track Video B, pastel blue)

l the sound or audio area
(Track Audio1 to unlimited amount, pastel brown).

I An unlimited number of still images, movie clips, transitions,
audio clips and titles etc. can be inserted into each track.

Further information can be found in the ’Reference - Timeline’ booklet.
Timeline Window
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Timegraph Window 

The Timegraph provides you with an overview of the temporal behaviour
of the effects. As you can move images and videos in various ways and
apply a multitude of effects to them, you would quickly lose control of
the animations and the changes made if you did not have the Timegraph.

Each track represents the editable parameter of an effect while each
keyframe (short vertical lines) represents an alteration of the parameter.
MoviePack automatically calculates the interpolation between the
keyframes. 

I The Timegraph shows the object which is highlighted in the
Timeline. As soon as you click on one of the icons or
parameters in the Timegraph you will automatically see the
effect with its parameters in the Effect Box and vice versa.

I An effect is always applied to the entire object (e.g. on a
Movie Clip in the Timeline). A keyframe is automatically
assigned to the beginning and end of the effect. Under Tools/
Options/General you can determine whether zero values should
be applied to the beginning and end or whether the effect
should begin immediately.

Scrolling Window Contents u Using the scrollbar enables you to
see other sections of the window that
were previousy invisible. The
operation of the scroll bars follows the
usual Windows standard.
Manual Tutorial Reference Effects
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I The window content can be moved in the Timeline and
Timegraph. In an empty position the pointer changes to a
yellow hand and by keeping the mouse button depressed
you can drag the contents in both directions.

Further information can be found in the ’Reference - Timegraph’
booklet.

Preview Window  

OpenGL or Direct3D Support is necessary if you want to use the Live
Preview in Realtime. OpenGL and Direct3D are standards for image
display acceleration on a computer screen. Although many graphics
cards already offer OpenGL acceleration, some do not support all
OpenGL commands and these are often limited to game applications.
Furthermore, acceleration depends on screen resolution and on the
amount of RAM available.

The Preview Window is freely scalable and both the effect calculation as
well as the output happens in real-time. Please ensure that you highlight
a preview area in the Timeline (green bar). The better the OpenGL or
Direct3D support the quicker the Preview.

Live Preview in Realtime should only be used for displays of up to 10
seconds as longer sequences will run better on Video Control.
Preview Window
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Effect Box Window 

All effects which have been applied to an object (movie clips, still
images, audio etc.) can be adjusted here in the Effect Box.

u Select the effect you want from either the Browser or an Album
and apply it to an object in the Timeline or Canvas. Move the
Timeslider to the point in time where you want the parameter
values to be changed.

The desired object must be
activated before you apply an
effect from the Browser.

The order in which effects have
been applied to an object can
greatly influence the final results.

I Select a different object in
the Timeline or on the Canvas and
the effect parameters will be
immediately shown in the Effect
Box.

I Keyframes are automatically
set to these effect parameters on
the Timegraph irrespective of whe-
ther it is open or not. All frames
between keyframes are rendered
automatically.

Further information can be found
in the ’Reference - Effect Box’ boo-
klet.
Manual Tutorial Reference Effects
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Monitor Window

The Monitor
window consists
of two monitors
which display the
two frames that
are represented in
the Timeline by a
red and a blue
marker.

Clever maneuvering of the clips with the help of these markers enables
you to find the exact optimal position in which the clips, using the
cutting tools in the monitor, can be processed. The markers can be freely
positioned and can also rest on the same track.(see the ’Reference -
Monitor’ booklet).

Album Window 

The Album is a container for images, videos, transitions, effects, settings
and behaviour and also helps to organize your project. Everything
necessary for a project can be collected and stored in an Album.

Click the Album icon and a new album with first of all one group will
appear. Sources from the Browser, Timeline or Effect Box ican be dragged
into an album.

Sources can be found in various folders. The Album guarantees you easy
access.
Monitor Window
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Video Control Window

Video Control is recommended for rendering longer animations which are
then output onto a TV monitor. Click on the Monitor button and the current
content of the Canvas is displayed on the TV monitor depending on the
video board. The data is entered once at the beginning and is then
valid.

The S button enables you to
determine the video and
rendering settings.

The Video Control renderer is a
special Intelli-Renderer which
only re-renders frames that
have been modified since the
last rendering. Unaltered
rendered frames are stored
in the cache.

T
This menu appears with a right-click in
the Video Control window and allows you
to set up the window whichever way
you desire.

To activate the rendering, click the red
button. All tracks including audio tracks
are rendered apart from those tracks in

the Timeline which have been locked. When the rendering process is
finished you can then playback the clip by clicking the Play button . 

The Monitor icon activates the playback on a connected TV (see the
’Reference - Preview’ booklet).
Manual Tutorial Reference Effects
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Closing your Animationu Either click the small cross on the right-hand side of the top
line or use the shortcut Ctrl + F4 .

Quitting MoviePackYou can quit MoviePack in three ways:

u Click the symbol  in the top right-hand corner of the
window.

u From the File menu select Close.

u Or use the shortcut Alt + F4 .
Video Control Window
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